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Related Manuals

To ensure system safety, always read and follow the information provided in all Safety
Precautions and Precautions for Safe Use in the manuals for the devices that are used in the
system.

The following shows the manuals for OMRON Corporation (hereafter referred to as OMRON)
and Delta Tau Data Systems, Inc (DT).

Manufacturer | Manual No. Model Manual name

OMRON 1610-E1 Model CK3E-LI1OIO Programmable Multi-Axis Controller
Hardware User’s Manual

OMRON W580-E1 Model NY510J-AJO0O | Industrial PC Platform NY-series IPC

Programmable Multi-Axis Controller
Hardware User’s Manual

OMRON W488-E1 Model GX-LJOOOOO | GX-ID/OD/OC/MD/AD/DA/EC/ILM,
XWT-ID/OD EtherCAT® Slave Units
User’s Manual

DT 0014-E - Power PMAC User’'s Manual
DT 0015-E - Power PMAC Software Reference
Manual

DT 0016-E - Power PMAC IDE Users Manual




2. Terms and Definitions

Term Explanation and Definition
Slave Slaves are devices connected to EtherCAT. There are various types of
slaves such as servo drivers handling position data and 1/O terminals
handling the bit signals.
Object Represents information such as in-slave data and parameters.
PDO One type of EtherCAT communications in which Process Data Objects

communications
(Communications
using Process Data
Objects)

(PDOs) are used to exchange information cyclically and in real time.
This is also called “process data communications”.

PDO Mapping The association of objects used for PDO communications.

PDO Entry PDO entries are the pointers to individual objects used for PDO
mapping.

ESI file An ESI file contains information unique to the EtherCAT slaves in XML

(EtherCAT Slave format.

Information file)

You can load ESI files into the EC-Engineer, to easily allocate slave
process data and make other settings.

ENI file
(EtherCAT Network
Information file)

An ENI file contains the network configuration information related to
EtherCAT slaves.

Power PMAC IDE

This computer software is used to configure the Controller, create user
programs, and monitor the programs.
PMAC is an acronym for Programmable Multi-Axis Controller.

Acontis
EC-Engineer

This computer software is used to configure the EtherCAT network and
each slave.




3. Precautions

(1) Understand the specifications of devices that are used in the system. Allow some margin
for ratings and performance. Provide safety measures, such as for installing a safety
circuit, in order to ensure safety and minimize the risk of abnormal occurrences.

(2) To ensure system safety, always read and follow the information provided in all Safety
Precautions and Precautions for Safe Use in the manuals for each device that is used in
the system.

(3) The user is encouraged to confirm the standards and regulations that the system must
conform to.

(4) It is prohibited to copy, reproduce, or distribute a part or the whole of this document
without the permission of OMRON Corporation.

(5) The information contained in this document is current as of July 2016.

It is subject to change without prior notice for improvement purposes.

The following notations are used in this document.

Indicates a potentially hazardous situation which, if not avoided,
may result in minor or moderate injury, or may result in serious
injury or death. Additionally, there may be severe property
damage.

/A WARNING

T C t Indicates a potentially hazardous situation which, if not avoided,
aution may result in minor or moderate injury, or property damage.

IE' Precautions for Correct Use

Precautions on what to do and what not to do to ensure correct operation and performance.

@ Additional Information

Additional information to read as required.
This information is provided to increase understanding or make operations easier.

Symbols

The filled circle symbol indicates operations that you must carry out.

The specific operation is shown in the circle and explained in text.

This example indicates a “general precaution” for something that you must
carry out.




Overview

This document describes the procedures used to connect the OMRON EtherCAT Remote I/0O
Terminal model GX-O1OOOOO (hereafter referred to as the Slave) using OMRON
Programmable Multi-Axis Controller model CK3E-LOOL/NY510-ALOO (hereafter referred
to as the Controller) and EtherCAT, as well as for checking the connection.

Refer to Section 6. EtherCAT Connection Procedure to learn about the setting methods and
key points to perform PDO communications via EtherCAT.



5. Applicable Devices and Device Configuration

I 5.1. Applicable Devices

The applicable devices are as follows:

Manufacturer Name Model
OMRON Programmable Multi-Axis Model CK3E-DIDOL
Controller
OMRON Programmable Multi-Axis Model NY510J-ALICIO
Controller Industrial Box PC
OMRON EtherCAT Remote I/O Terminal Model GX-UJOOJOOO

IE' Precautions for Correct Use

In this document, the devices with models and versions listed in Section 5.2 are used as
examples of applicable devices to describe the procedures to connect the devices and check
their connections.

You cannot use devices with versions lower than the versions listed in Section 5.2.

To use the devices mentioned above with models not listed in Section 5.2 or versions higher
than those listed in Section 5.2, check the differences in the specifications by referring to the
manuals before operating the devices.

@ Additional Information
This document describes the procedures to establish the network connections. It does not
provide information on operations, installations, wiring methods, device functionalities, or
device operations, which are not related to the connection procedures. For more information,
refer to the manuals or contact your OMRON representative.



I 5.2. Device Configuration
The hardware components to reproduce the connection procedures in this document are as

follows:

Model CK3E-OOOO Model GX-ID1611

Windows computer Model GX-OD1611

Power PMAC IDE p
Acontis EC-Engineer )
. -
£ % 0
T EtherCAT

Ethernet
communications communications
Manufacturer Name Model Version
OMRON Programmable Multi-Axis Model CK3E-L1OIOM Ver.2.2
Controller
. Model GX-ID1611
OMRON EtherCAT Remote I/O Terminal Model GX-OD1611 Ver.1.1
OMRON Ethernet cable (with industrial Model
Ethernet connector) XS5W-T421-[L1IMUI-K
- Windows computer -
DT Power PMAC IDE - Ver.2.2
Acontis Acontis EC-Engineer - Ver.2.4.3

El Precautions for Correct Use

Prepare the ESI file described in this section in advance. Contact your OMRON
representative for information on how to procure the ESI file.

IE' Precautions for Correct Use

Do not share the connection line of EtherCAT communications with other Ethernet networks.
Do not use devices for Ethernet such as a switching hub.

Use the Ethernet cable (double shielding with aluminum tape and braiding) of Category 5 or
higher, and use the shielded connector of Category 5 or higher.

Connect the cable shield to the connector hood at both ends of the cable.

@ Additional Information
This document describes model CK3E-LICIC1C as an example. The same procedures can
apply to model NY510J-ACICIC.

©



6. EtherCAT Connection Procedure

This section describes the procedure for connecting the Controller with the Slave via
EtherCAT. The description assumes that the Controller and the Slave are set to factory

default.

I 6.1. Workflow
Take the following steps to operate the PDO communications via EtherCAT after connecting
the Controller with the Slave via EtherCAT.

6.2 Preparation for the Controller Setup Prepare the Controller settings.
v

6.2.1 Creation of a New Project
v

6.2.2 Initial Settings of the Controller
v

6.3 Installation of ESI Files Install the ESI file for the Slave into
v Acontis EC-Engineer.

6.4 EtherCAT Communications Setup Set up EtherCAT communications.
v

6.4.1 Communications Setup for the EtherCAT Master
v

6.4.2 Distributed Clock Setup

6.4.3 PDO Map Settings
v
6.4.4 Creation of an EtherCAT Network Configuration
File

v
6.5 Controller Settings Set up the Controller.
v
6.5.1 EtherCAT Network Configuration Settings
v
6.5.2 EtherCAT Communications Check
v
6.5.3 EtherCAT Variables Settings
v
6.5.4 Writing the User Program
v
6.5.5 Project Data Transfer

10



I 6.2. Preparation for the Controller Setup

Prepare the Controller settings.
Install Power PMAC IDE and Acontis EC-Engineer on the computer in advance.

6.2.1. Creation of a New Project

1 Connect the Controller with the
computer via Ethernet cable.

2 Turn on the power to the
Controller.
3 Start Power PMAC IDE.

* If the dialog for confirming
access rights appears upon
start-up, select starting of Power
PMAC IDE.

4 The Communication screen

appears. Specify the IP address | & Delta Tau Data Systems Inc. Envimnmeng. (e o |
of the destination Controller and Communication | I

click Connect. o= 41 |
= £

IPAddres=s 192 1680200 [=]
Port 22

* The IP address of the

Pratacal 55H
Controller is set to User root
Pazzward 55558888
“192.168.0.200” by default. fpply &11Controls True
* |f necessary Change the SelectDevice AtStartup True
Windows IP address to
“192.168.0.X". IPAddress

Set [P Address

[ Connect ] [Last Session I [ Mo Device ]

For detailed setup options go to Tools menu -= Options
-> PowerPMAC

11



5 Power PMAC IDE starts, and is
online to the Controller.

.-‘_ Pawer PMAC Suite (TT9E)

Flla Edit View Project Puld Dabug Tools Delts Tou Window Help

HT AR - - B P Wy R b Debug ¥ AnyCPU

e

[ YUz —5-32 ‘Powerbmac’ (1 7O T
RS o verrmac(ro Device |

@ 3 € Language

- 3 Configuration

- [ Docurmentation

- 3 Log

@ (23 PMAC Script Language

Eeice e

5 ¥ 1K | posrerPmac(No Device:) Profect roper +
EOTEOERE): Euk =l |l oh s |
L - wlBum.
T User Buter 1 -
:E PowerPMAC Communication Setup ]
JOST o PowerPmac GHFRCHMILE L. =
6 From the File menu, select New
-
then Project. < Power PMAC Suite (Administrator)
Edit View Tools Delta Tau Window Help
New » | 5] Project... Ctrl+Shift+N u
Open » | O File.. Crl+N tup _
[ Close Project From Existing Code...
| 55| close Soluti
1 | Close Solution E—
H [l | Save Selected Items  Ctrl+S
| 2233567
Save Selected Items As... 025
I i@l | saveall Ctrl+Shift+S _
Export Template... i)
|| @ | Page Setup...
| & | Print... ctri+p P
H Recent Files » ;
1 Recent Projects b
Exit
7 Enter a project name and
location, and select OK. s
Propect tpms: Ieremi: (L 3E=2
Fowerirec [ ey e ————
thes Propect Tvoes
[Feees Friac.
T [Eracrszan
Lcatione - Browim...
Soktonhage: | [CTacien  reae drectony b st
Czr o |
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6.2.2. Initial Settings of the Controller
Configure the initial settings for the Controller.

IE' Precautions for Correct Use

Configuring the initial settings clears all data in the Controller memory. Back up necessary

data in advance.

In the Terminal pane, type the
$$$*** command to reset the
Controller to factory default.

File Edit View Project Build Debug Tools DeltaTau Window Help

- =" N- I - - - [ Debug -

Watch: Online[192.168.0.200:55H] » & x| Position: Onli

Send On Command Response |
Demand
T W opseoom oses
[ ECATIO] Ensble 1

] Slave_0_B071_0_Targettorque  |stdin:3:2: err... | ~

Terminal: Online[192.168.0.200:55H] -3 x pp_disable.
[1#%k
[ 3%

disab
clear

enabl

555 a

2 From the Tools menu, select
System Setup to start System
Setup.

PowerPMAC System Setup
starts.

= Poweer PMAL Sute (Admunistrator]

Fla Bt Vew Debug |Took | DelaTes ‘Andsw  Hels
= g

"3 il
W Termna 5 powion ] B P
Wiskch! Orine[ 190080, 0. 200 TEE LY
On | B TaskMansger
Sand Dl Cnrnrni L S
| L
] ECaTi| ©
‘m gcaTif W | Aktach to Process Chi+alt+f
C |ecam] el
External Tooks..,
Do, .,

AL Syt Serup : OnbnaltPY.164.0.00; 58]

o e PAM Frocpercy O Ieeihad Barvs Accerscry, Sl the Hadn ared Sam.

13



3 From the File menu of
PowerPMAC System Setup,
select New then Setup.

PowerPMAC System Setup : Online[192.168.0.200:5S5H]

File | Database

| New 3 Setup I
Add »
Save Setup
Restore Setup

4 Specify Servo Frequency.
Global Clock Setting

Select the Servo Frequency

setting from 4 kHz, 2 kHz, or Phase Fraquency 1.000 kHz
1 kHz. _

Servo Frequency 1000 =) kHz
* Servo Frequency is set to Detected Servo Hardveare-PWM Frequency
1 kHz for the example in this
document.

5 Click the Accept button.

B <)

9

o el
Nowe clock  Power PMAC w’: |

settings Walue
Servo Period (msec) 1000 1000
FhaseOverServoPeriod 1000 1000

Ttems

No Master Gate detected and No - L 1

ETHERCAT option detected

PowerPMAC can be used as a PC using |
. software clock. (sys. CPUTimerdntr = 1) On |~

Accepting the clock issue save and 555

in the terminal window for changes to

take effect Check ‘sys.ServoTime’ to

6 If you have changed the servo Terminal: Online[192.168.0.200:55H] - 1 ¥
frequency setting, type the save
command in the Terminal pane
of Power PMAC IDE.

When complete, the “Save
Complete” message appears in
the Terminal pane.

|SE"\I'E

14



~

Click Communication Setup on
the toolbar to display the Device
Properties dialog box.

ﬁ?ﬁw&iﬁéﬁmq izm)

l File Fdit View Debug Tools Delta Tau Window Help

3l- -5 d a

Watch: Dffine

W Terminal B poston B watch I States i Jog Riflan i Cormmunicaon Setug) -

-0 X

e -ces 1oa0-5

Send &HM Carnrmard Emmpm_ 3
Fm‘ | [ ] [ ]
.. P30t ﬁ“
W I::I:;r-;n.msﬁ(s]; > Ll = o
g In the Device Properties dialog 2 Device properties NN =
box, select No Device for IP ERCEE R
Address, then click the Apply L
button. e F
Protacol S5H L
Elser rlm‘t AAAAAA =
This operation sets the Phddress
Controller to the offline state. .
o] The Controller restarts.
The servo frequency that has
been set is reflected.
10 Wait until the startup process of | % Device Properties -
the Controller is complete. Then LTt | [ e
click Communication Setup on

the toolbar to display the Device
Properties dialog box.

In the Device Properties dialog
box, return the IP Address to the
previous setting, then click the
Apply button.

This operation sets the
Controller to the online state.

FortMumber

| Protocol S5H
U=zer root
IPAddress

Set IP Address

15



I 6.3. Installation of ESI Files

Install the ESI file for the Slave into Acontis EC-Engineer.

M Precautions for Correct Use

Prepare the ESI file described in this section in advance. Contact your OMRON
representative for information on how to procure the ESI file.

1 Start EC-Engineer.

£ Power PMAC IDE v

-_-_| Windows Explorer >
=
| # EC-Engineer 3
_>
.__',L-;!’/.' Paint 13

b All Programs

| | Search programs and files e |

Hart Fage |

EC «Engineer

16



2 From the File menu of
EC-Engineer, select ESI
Manager.

The ESI Manager appears.

View

Network  Settings

Help

2 New Ctrl+N
= Open Ctrl+0
H save Ctrl+5
K save As

Print

*' A Mactor Lot 3

ESI Manager

e

= Recent Projects »

Exit Alt+F4

Example of the ESI Manager

[ &1 Manager @ —

[F=SE =)

ESI Files
Select an ESI file which should be delated or exported or
* L Baumueter Nuemberg GrmbH
* Bl Becknolt Automation GmbH & Co. KG
| ¥ € Copley Cantrals Carp
P L Lenze
b B OMRON Corporation
B VIPA Gtk
>

¥ vaskawa Dectric Comoration

Add File Add Folder

madd raw ESI files,

Number of ESI files: 79
Number of devices: 1930 .

Cloge

3 Confirm that Omron GX-Digital
10.xml is registered in the ESI
file list of the ESI Manager.

If it is not yet registered, click
Add File and register Omron
GX-Digital 10.xml.

m ESI Monager -~ Mo

S Files

Select an E51 file which should be deleted or exported or add new ESI files. |

b L oLeaze

Semewme

]
Number of ESI files: 78
Number of devices: 1925

= Crmwon GX-IC

B Pctures (= Omwen GE-C06-H
B videos 2! Omion NX_Coupler
= _Dmwrn N Madeiles

™ Computer =5 m

File parnes Demacn G- Digital 10

Add File Add Folder Close
= =)
=] « Documents » syutembsvies o)
Grganize - PMew tokder = _\J ‘

1 Faventes Dnru_n‘_l?nfs library pradgi' o
BB Deskiop Systemiafiles
By Downioeds Hame 3
L Recert Places
. .
. = Gmion GX-Digitsl 10
il Linraries
i Recomanss [+ Dmren Gi-Encoder
o Music F

4 Click Close to close the ESI
Manager.

17



I 6.4. EtherCAT Communications Setup
Set up EtherCAT communications.

M Precautions for Correct Use

Before taking the following steps, make sure that the devices are connected via an Ethernet
cable. If they are not connected, turn OFF the power to the devices, and connect the Ethernet
cable.

6.4.1. Communications Setup for the EtherCAT Master

1 Connect the Controller with
slave devices using an Ethernet
cable.

* Refer to the manuals for slave
devices to configure them.

2 Display Start Page of the

EC-Engineer, and select W M
EtherCAT Master Unit (Class el
A) from Add Master Unit. - EC #Engfneer
1
! -
-_
-_—
A=
. i —-—
= C:Wiserss, Nproject GX-DC06...1.e0c ;!_;‘Tf |:| :

3 Class-A Master is added to the | S50 oo
Project Explorer. :

it Mame Class.A Master
Cyde Time [us) 1000
‘Source MAC address

18



4 'nthe Master page, specify a
communication period for Cycle

General

Time [us]. —=

Cycle Time [us] 1000

Source MAC address
* H Slaves connected to local system

YOU must SpeCIfy the Mty Aciapter T—r TUPHEE ( Intel{R) Ethernet Connection 1217-LM )
communication period in Gt
accordance with the servo e
192.168. 0 . 200
frequency of the Controller. o oo
aster-Instance o Selact

1000 us is set in this document.

Correspondence between the servo frequencies of the
Controller and communication periods is as follows:

4 kHz : 250 us

2 kHz : 500 us

1 kHz : 1000 us

5 In the Master page, enter the IP s
address of the Controller in IP

General
Address, and click the Select sy Clase-A Moster
Cycle Time [us] 1000
button to apply the setting. Aot W ke
Slaves connected to local system
Nebwork Adapter O—f1r TUPHEE ( Intel(R) Ethernet Connection L217-LM )
* Default IP address P
192.168.0.200” is specified in W
this example. R : |

* Do not select Slaves
connected to local system as
it is not used.

6 Right-click on Class-A Master sl =l

File  View MNetwork Settings Help

£ Configuration Mode ™| B Diagnosis Mode

in the Project Explorer, and
select Scan EtherCAT

Project Explorer Device Editor
Network from the menu. . Class-A Master S—
dF Append Slave General
Unit Name
% Remove Master-Unit Cycle Time
Source MAC
Slaves conn¢

= Import Slaves from ENI File Network Ad

# Change Master Unit

19



7 Make sure that the slave is
displayed in the Project
Explorer.

-

EC-Engineer [--]

File View MNetwork Settings Help

{ Configuration Mode ™ ==yl

Project Explorer

-

=loss-A Master

U Slave_1001 [GX-ID1611] (1001)
£ Slave_1002 [GX-0D1611] (1002)

20



6.4.2. Distributed Clock Setup

w EC-Engineer [—1 i S -.— - l

1 In the Project Explorer, select
Eile View Network Settings Help
the targ et Slave GX‘I D1611 tO ¢ Configuration Mode ™ E=ilded=1s B Diagnosis Mode

display the Advanced Options DonceEdr = |
= ‘ General H PDO Mapping || Varial Cnmmands” (

Gied lloctar
tab page | == Slave_1001 [GX-ID1611] (1001) ‘ I Overwrite Watchdog
= - = Set Multiplier (Reg.: 0x400): | 22385

Set PDI Watchdog (Reg.: 0x410); 100083(100.000 ms)
Set SM Watchdog (Reg.: 0x420): 100083 (100.000 ms)

I Distributed Clocks
i ]i Potential Reference Clock

* |f the Advanced Options tab page does not appear, select
View then the Expert Mode check box.

r
=+ EC-Engineer [--] .
File Network  Setting
= Massages
Short Info
I Expert Mode
|— Refresh F5
I [-1 e E B 1
H =+ EC-E - -
2 In the Advanced Options tab noneer !
File View MNetwork Settings Help
page, clear the Potential ke Export NI 8 Diagnosis Hods
Devie ol
Reference Clock check box. e e i
| Class-A Master | General | PDO Mapping | Variables| Advanced Options | Init Commands | «
£ Slave_1001 [GX-ID1611] (1001) | Overwrite Watchdog
& Slave_1002 [GX-0D1611] (1002) Set Multiplier (Reg.: 0x400): 24089
Set PDI Watchdog (Reg.: 0x410): 100083 (100.000 ms)
Set SM Watchdog (Reg.: 0x420): | 100083(100.000 ms)
I Distributed Clocks
i Potential Reference Clock

3 In the same manner, clear the
Potential Reference Clock
check box for GX-OD1611.

@ Additional Information
Remote I/O Terminal model GX-UIOOOCC does not support DC Mode.

Disable the reference clock by taking the steps shown above.

21



6.4.3. PDO Map Settings

1 In the Project Explorer, select
the target slave
Slave_1001[GX-ID1611] and
display the PDO Mapping tab
page.

Eie  Yew  Hetwork  Settngs el

I Export B B Diagross Mode
BAE-R, AT etz l POO Mapping i!lﬂh‘& Advarced Options | In® Commands | Coll Object-Dickionary

influts Outputs
- 57T trwnems BDO Mapging (e 0xiB00 *

T Bt Lengtn

w & 258sh transms POO Mapsing | k103

Bt Lengt

ol
Pt BROZ 03020 03
_'ia_uffr; Flat View | Topology View
2 Check Inputs to make sure that Inputs
only the 258th transmit PDO Y 43Tovbansial PEQ Wagowy [eahuded | 0100
Mapping check box is selected. et i 2
=
[T Loke Bt Lengih
Imput BetDO Ox3020:01 1
Imput BatD1 0=3020:02 1
Input Bat02 Ce3020:03 1
Inmput BatD3 3020:04 1
Imput BatDd O=3020:05 1
Input BatDS Cec3020:06 1 »
= EC-Engineer [--] - e | - e | D i

3 In the Project Explorer, select
the target slave
Slave_1002[GX-OD1611] and
display the PDO Mapping tab
page.

| File  Wiew petwork  Settings  Help

e v TR

B Disgnesis Mod

-
| - Class-A Master Gersernl | PO Mapeing | variabidl | Advarced Options | Int Commands | Cof Dbjeet-Dicticnary
R e ! |
SLIN tranemit PO Magaing GAUFF | | v [ 257 rsceve POO Massing [ae | BN1200
| proe Irdder Bt Lengt N 1
| £
SpmecEmors GANZDL B Write output 1| Dx6300:01
‘ v ) 255 receve POOMagping | D701
Hame tndex Bt tergin

| Cutget BIOO | 322008
Outpet D401 | 322002 1

Outset BAOJ | Ox3Z20:03

Classi= view | Fiat View | Topology View

4 Make sure that the check box in
the Inputs field is not selected.

Inputs
v |:| S512th transmit PO Mapping 0x1BFF
Name Index Bit Length
Sysmac Error 5 0x2002:01 8

22



5 Make sure that only the 258th
receive PDO Mapping check
box is selected in the Outputs

field.

Cutputs
- 257th receive PDO Mapping (exciuded by Cwi?01)  Ow1700 °
Hame Indiex Bt Length
Nrte t  LER Vet
w [ 258th receive PDO Mapping x1701 B
BT | =173 LEmgLT
Ouitput BROD (3220:01
Cutput Bal 3220:02
Cutput Ba02 O3220:03
Qutput B203 0x3220:04
Cutput 804 FeIIILDE
Cutput BEOS X200 1
e Bl feEnnT

6.4.4. Creation of an EtherCAT Network Configuration File

Click Export ENI on the upper
1
part of the EC-Engineer page.

= EC-Engineer [--]

File View Network Settings Help

= Export ENI

£ Configuration Mode

B Diagnosis Mode

2 Enter a file name, and then click
Save to create an EtherCAT
network configuration file.

=+ Export EtherCAT-Metwork-Information (ENI) File

@E}v . ¢ Computer » Local Disk (C:) » tmp

Organize v New folder

&, Local Disk () »
. DeltaTau
| ingtpub

Name

./ Intel

|/ OE-Downloade—
./ Omron
. Perflogs

.. Program Files

. Program Files {

Date modified

Ne iterns match your search.

M tmp L] 1

Type

1
I File name: m I

Save as type: IEthErCAT-NEtwork-Infnrmation (ENI) Files (*.3ml)

* Hide Folders

I 6.5. Controller Settings

6.5.1. EtherCAT Network Conf

iguration Settings

1 From the Tools menu of Power
PMAC IDE, select System
Setup to display System Setup.

PowerPMAL System Setup ; Ondned 192.168.0,200:554]

B ===

| File Datasase

=4y Powwes PMAC (152 1680 200
T Hardmarn Dispross:
o-4f Motors
ol

EtherCAT. ~

EXhrCAT Licanse Status: EtherCAT 10 Devices Liconss Only
EtherCAT Master hype: ACONTIS

Browse to eni file

23



2 Click Browse, and load the

PowerPMAL System Setup © Ondnef 192.168.0,200:58H] e plE)

File Datahase

EtherCAT network configuration 17 PomePHAG (181550 em—
. . ) o 4 e EtherCAT. ™
file created in 6.4.4 Creation of * LERIOETETE N
an EtherCAT Network EmerCAT Mastr e ACONTIS
Configuration File. it e
3 Click Download ENI file to a
EtherCAT.

download the EtherCAT network
configuration to the Controller.

EtherCAT License Status: EtherCAT IO Devices License Only
EtherCAT Master type: ACONTIS

Browse to eni file

Bﬂ?ﬂ‘!!

6.5.2. EtherCAT Communications Check
Take the following steps to ensure that EtherCAT communications are available.

1 From the Terminal pane, run the
ECAT[0].Enable=1 command to
start EtherCAT communications.

Terminal: Online[192.168.0.200:55H]

ECAT[0].Enable=1

2 In the Terminal or Watch pane,
make sure that the

ECAT[0].Enable value turns to 1.

*The OP mode is entered and
EtherCAT communications are
established.

Watch: Online[192.168.0.200:55H] -~ 0 X
Send g;mand Command Response
(] [l Py 3 4774 E 40
ECAT[0].Enable 1
ECATIO0].Error 50
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3 After making sure that correct D ——— re—
communications are available, Send g;mand Command Response
run the ECAT[O].Enable=0 [ |SysServoCount | 1821361
command from the Terminal ] ECAT[0].Enable 1
pane to stop EtherCAT . ."_“i ECAT[0).Error $0
communications. k) ©

T[0].Enable=1

ECAT[0].Enable=0
4 In the Terminal or Watch pane, Watch: Online[192.168.0.200:55H] —
make sure that the On
Send D & Command Response
ECAT[0].Enable value turns to O. SITier
] Sys SenoConnt 18522814
ECAT[O].Enable 0
ECATIO].Error 50

6.5.3. EtherCAT Variables Settings

1 In the System Setup page, " PowerPMAC System Setup : Online[ 192.168.0.200:SSH]
right-click on File  Database
Master[O]_Deactivated to ?---«.\.‘ EowerPMAO (192.168.0.201

display the pop-up menu, and
select Export EtherCAT
Variables.

: —
EterCAT.
B L 5] Master [0] Deackasiss

Export EtherCAT Variables =
TUTET AT CICETTS e OTaTos: |_tI'IErCF"T 10 Device

EtherCAT Master type: ACONTIS
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2 Enter a name for the EtherCAT
variable definition file for user
programs into the root of the
project folder.

-
. Save As

@O-‘;_‘ « My Documents » uite »
- —

-1%]

Organize v New folder

I Favorites fe
B Deskiop Bin
& Downloads C Language
"G Recent Places Configuration

Documentation

i Libraries L Log
[ Documents | PMAC Script Language
@ Music
&) Pictures
B videos

1% Computer
&L, Local Disk (C)

Date modified

7/8/2016 8:42 PM
7/8/2016 8:42 PM

2016 8:42 PM
7/8/2016 8:42 PM

Type

File folder
File folder
File folder
File folder
File folder

File folder

File name:  ECAT Variables|

Save as type: | ppmac header files (*.pmh)

5

= Hide Folders

Save Cancel

3 The created EtherCAT variable
definition file is added to under
Global Includes of PMAC
Script Language in Solution
Explorer.

Position: Onling[19... ~ & X | Velocity: Onling[192.... v 3 X

T

B

Following Error: Onli.

~ 1 % | Solution Explorer - Solution .. ~ & X

=)

[ Selution "PowerPmac2’ (1 project)
- ] PowerPmac2(192.168.0.200:x¢
- £3 CLanguage

- [ Configuration

[ Documentation

[ Log

#define Slave 0_3220_1_OutputBit00
#define Slave 0_3220_2_OutputBitol
#define Slave 0_3220_3_OutputBit02
#define Slave 0_3220_4_OutputBit03
#define Slave 0_3220_5_OurputBit04
#define Slave 0_3220_6_OutputBit05
#define Slave 0_3220_7_OutputBit0é

ECAT[0]
ECAT[0]
ECAT[0]
ECAT[0]
ECAT[0]
ECAT[0]
ECAT[0]

.I0[0]
.Io[1].
.Io[2]
.I0[3]
.I0[4]
.I0[5]
.Io[6]

.Data

Data

.Data
.Data
.Data
.Data
.Data

=)

- [ PMAC Script Language

.= Global Includes

El] ==t variables.pmi)

- [ Kinematic Routines
- 3 Libraries

[ Motion Programs
[ PLC Programs

T r
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6.5.4. Writing the User Program
Create programs to be used to check operations.
A specific language is used for the operation check programs. Refer to Power PMAC User’s
Manual and Power PMAC Software Reference Manual for details.

1 In the Solution Explorer pane,

open Project name — PMAC daw . Help
g = Sy CPU = | 5 1800 = | By 59 % I Teminal T

Script Language — PLC PO
Programs — plc1.plc. 2

- 3 M| Velocy Oaline_ ~ 3 M || Following Eron.. = 3 M| | Sohuton Explo Coktion - 3 ¥

PR Sustom_iareatpl
N pp dasbleta
: pp_in_dizaihs tet
8] pp_inc_startup.ta
P tavn.cly

mpecat.clp” ecatactivatel.ofy | X051000 | 20151008pmh = x & ppstartup.b
Tl Docementation
< L
L= PMRAC Sonpt Lavguage
L Global Inchades
151028 pmk
glckal definftions.preh

i Kinematic Routines
& [ Libwwnes
v 23 Mstion Programi

Propsertied - 2N

" ||| ecatscthvatellcly Fie Properties
w1, ]

2 In the programming area of the open plc 1
plcl.plc tab page, write a

) while(sys.ecatMasterReady==0){};
program as shown on the right.

ECAT[0].Enable=1;

_ _ P1001 = Slave_0_3020_1_InputBit00;
This sample program substitutes

the state of the GX-ID1611 input | close
terminal (OFF:0/ON:1) for the
variable P1001.

* In this example, PDO mapping
is assumed to be the default
setting. If you want to change
PDO mapping, rewrite the
“Slave_0....” description.
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3 Setting the start of the user

program ndow  Help

thwug - Ay CPU v | [ 1800 - | g = N Terminal

In the Solution Explorer pane,

o Inchade
2015038 h
PP progh

open Project name —
Configuration —
pp_disable.txt.

i Lsbwmries
¥ [ Resitene Eoutices

2 Configueation

prodisabletet | myscatelp| ecstactvated.cly | 200500080 s

ecatactiated chy
FE /FELll all the motora (This apriar 1

iR fRBsET
disable plc 0..31 FifDimable all Script PLO»

clear sll buffers

ppsavecy
5] pp_steriup
& [ Documentation

i leg

pp disable twt File Propeties
sl

4 In the programming area of the
pp_disable.txt tab page, add the enable plc 1;
program shown on the right to
the last line.

The pp_disable.txt program is
automatically executed when the
Controller starts.

This example program runs the
PLC1 script.
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6.5.5. Project Data Transfer
Transfer the created project data to the Controller.

/A WARNING

When the user program and “configuration and setting” data are transferred
from Power PMAC IDE, devices or the machine may perform unexpected
operations.

Therefore, before you transfer project data, ensure the destination slave is
operating safely.

Transferring project data restarts the Controller and interrupts communications
with slaves. The time that communications are interrupted depends on the
EtherCAT network configuration.

Before you transfer project data, make sure that the slave settings will not
adversely affect the devices.




1 In the Terminal or Watch pane,
make sure that the
ECAT[0].Enable value is 0.

If the value is 1, run the
ECAT[0].Enable=0 command
from the Terminal pane to stop
EtherCAT communications.

- Power PMAC Suite (Administrator)
File Edit View Project Build Debug Tools DeltaTau V

ERNERA-N" W - AR MR A RS =R S [

Loar || = 2|3 103 4 Ba
@ Terminal + Position [ Watch J§l Status [ Jog Ribbon | <% ¢
Watch: Online[192.168.0.200:55H] ~ 1 x
Send 2 Command Response
Demand
7] || |EcATIOLEnable 0

#1- Make sure that ECAT[0].Enable=0

Terminal: Online[192.168.0.200:55H]

2 Downloading a project

Right-click the project name in
the Solution Explorer pane on
the upper right of the IDE
screen, and select Build and
Download All Programs to run
the build and download.

Solution Explorer - Powe... » I X

=
‘oA Solution 'PowerPmac_ECC201+S

=S| PowerPmac_ECC201+5afe

=+ [z C Language Build
- [ Background K Claan
- [ CPLCs
- 3 Include Debug
3 Libraries Build and Download All Programs
- 1 Realtime Rot

Download All Pregrams
+- [ Configuration

+- [ Documentation
+ £3 Log Add Macro Project

Map PMAC Variables

%) [ PMAC Script Lan % | cut
X | Remove
Unload Project

< L[] Properties

‘=
Properties >~ I'X ] r

3 Make sure that there are no
errors in the Output tab page.

* |If the transfer fails, check
details of the error in the Output
tab page.

If the error is a program error,
you must review the program.

If the error is related to
EtherCAT settings, return to
System Setup and check
whether there are any incorrect
settings.
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The program starts running
when it has been downloaded
successfully.

EtherCAT communications are
in the OP state.

Vary the GX-ID1611 input and
make sure that the variable
P1001 changes in the Terminal
or Watch pane.

* If the variable does not
change, check that the
ECAT[0].Enable value is 1 in the
Terminal or Watch pane.

If the value is 0, run the following
command from the Terminal
pane.

enable plc 1

Watch: Online[192.168.0.200:55H] @
Send 7 Co d R
20N Demand miman E3poNse
Qﬁ LAY o Tah DEIEA D

--:-_

ECATI0l Enable
L] D

After you have confirmed an
appropriate operation, save the
project to the Controller.

Run the save command from the
Terminal pane.

* The transferred project is not
yet saved to the Controller at
this stage.

If you turn OFF the power to the
Controller, the transferred
project will be discarded.




7. Appendix Saving and Loading a Project

The following describes the procedures to save a Power PMAC IDE project on the computer, and to
reuse it.

I 7.1. Saving a Project

1 Creating a Configuration File

- B pp_proj.h

----- 1 Libraries

[+ [ Realtime Routines
Create a Configuration File to save [EBNER] Confiouratigs

T | T I | 7] ecataq Add 3

parameters you have changed in System || @ . BT —"
Setup to the project. || 7 L pp_cus -

""" =| pp_dis Upload Config Files

R 0T Download Config Files
Right-click Configuration in the Solution || = . g Generate Configuration File
Explorer pane, and select Generate || = P

[ [ Dooumentation

Configuration File. . P ian

A Configuration File is added to
Configuration.

2 Right-click on the Configuration File, and 5 Configuration
from the menu, select Check To Download - |7 FEFFSITEEs
Config File to include it in files to be )
downloaded.

m

[

Open With...
View Code

|:||I |ﬂ'., |:||I |':
[i]

Exclude From Project

>< Delete

2 L[

. Rename

]
Check To Download Config File

Prope
.| k=] Properties
3 Saving a Project 4 Power PMAC Suite
| File IEdit View
In the File menu, run Save All to save the W=y
. Open
project on the computer.

Add

Close

I ] | Close Solution
Upload Projec!

[ | save uPowerF

Save uPowerP

I i@l Save all I
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I 7.2. Loading and Downloading a Project

1 Start Power PMAC IDE, and
connect to the Controller.

2 In the Terminal pane, type the
$$$*** command to reset the
Controller settings to factory
default.

Terminal: Online[192.168.0.200:55H]

S G

3 In the File menu, Click Open —

“ Power PMAC Suite (Administrator)

PrOjeCt/SOIUtion tO |Oad the Edit View Tools Delta Tau Window Help
. New » t - - Debug vH»‘ar,- CPU v‘ .7
project that you saved. - .
@1 Project/Solution...  Ctrl+5Shift+0 H -
5 | File... Ctrl+0 l I ¥ || velodity:
Response =
) - 0177640
I gl saveall Ctrl+Shift+5
Export Template -
Page Setup
Print +P
Recent Files 4
Recent Projects 2
Exit
4 From the Tools menu Of Power PowerPMAC System Setup : Ondne{192.168.0,200:55M] 1 (2]
File Database
PMAC IDE, select System Setup A7 i T AR —
to display System Setup. ) SR e
EtherCAT Master ype: ACONTIS
Browse to eni fils Browse Duwnivad ENI te
5 Click Browse, and load the ENI St
EtherCAT.

file created in 6.4.4 Creation of an
EtherCAT Network Configuration
File.

EtherCAT License Status: EtherCAT IO Devices License Only
EtherCAT Master type: ACONTIS

Browse to eni file

Download ENI file |

6 Click Download ENI file to
download the EtherCAT network
configuration to the Controller.

—
EtherCAT.

EtherCAT License Status: EtherCAT IO Devices License Only
EtherCAT Master type: ACONTIS

Browse to eni file

B{m
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7 Right-click Configuration in the ~ Seliioneplorsr=Soluf= X
Solution Explorer pane, and select =
Download Config Files to
download the file to the Controller.

=8 &= Include -
L[] 20160204.h

‘[ pp_proi.h

. 1 Libraries

+- [d Realtime Routines

- || ecatactiva Add ,
|| myecat.cf] -
pn_custon i | Properties
| pp_custon Uplead Config Files
- |2 pp_disable Download Config Files
" ? pp_inc_dis Generate Configuration File
- 2] pp_inc_sta.—,
| pp_save.cfg

J

- 2] pp_startup.bxt 18

8 Right-click the project name in the | Selution Explorer - Powe... v I X

Solution Explorer pane, and =
. [54 Solution 'PowerPmac_ECC201+5

select Build and Download All M ] PowerPmac_ECC201+Safe

Programs to run the build and 7[5 Clanguage | &) | Build
. B~ 3 Background R Clean

download. . @ 0§ CPLGs
: + L3 Include Debug »
! ----- (3 Libraries Build and Download All Programs

When the download process is . @ [ Realtime Rod Bovmbood All Progams

+ @ Configuration

complete, make sure that there - B2 Documentation Map PMAC Variables
are no errors in the Output tab 3 [ Log Loz
+-- [ PMAC Script Lan % | cut
page.
X | Remove
Unload Project
1 L[} i= | Properties
Properties - 1I'X l r
O Stopping a program Terminal: Online[192.168.0.200:55H] ~ 0 X
If a program is running, execute I
the following command from the
i |disable ple 1

Terminal pane to stop the
program.
disable plc 1 Terminal: Online[192.168.0.200:5SH] S

ECAT[0].Enable=0

”EDAT[IJ].EnabIe=D
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10

Saving the downloaded settings
and programs

After the download process is
complete and you make sure that
there are no errors in the Output
tab page, run the save command
from the Terminal pane.

* The save command stores the
downloaded project in the
Controller. This operation saves
the settings to be executed
automatically when the power to
the Controller is turned on.

Terminal: Online[192.168.0.200:55H]

Save Complete

}53"!’&

11

Restarting after download

Run the following command from
the Terminal pane to restart the
Controller with the downloaded
project.

$$3$

Terminal: Online[192.168.0.200:55H]

”555
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8. Appendix Troubleshooting

8.1. Factors Causing EtherCAT Communications To Be Unavailable, and
Corrective Actions
Description Factor Corrective Action

The link is not established.

The Ethernet cable is broken or
the specified cable is not being
used.

If the Ethernet cable is broken
or if the specified cable was not
used, replace the cable.

A connector on the Ethernet
cable used for EtherCAT
communications is
disconnected, the contact is
faulty, or parts are faulty.

Reconnect the connector and
make sure it is mated correctly.

A slave within the EtherCAT
network configuration failed.

Replace the slave.

EtherCAT communications do
not start.

ECAT[0].Enable is set to 0.

From the Terminal pane, run the
ECAT[0].Enable=1 command to
start EtherCAT communications.

The EtherCAT network
configuration in the Controller
does not agree with the
physical network configuration.

Review the settings according
to the procedures provided in
6.4 EtherCAT Communications
Setup.

The Ethernet cable is broken at
a slave in the network, or a
connector is disconnected.

Connect the Ethernet cable
correctly.

Some errors have occurred,
and the ECATJO].error is setto a
value other than 0.

Check the ECAT]O].error value.

A synchronization error occurs
at a slave.

The distribution clock is not set
correctly.

A slave in Free-Run Mode is set
to the reference clock.

Review the settings according
to the procedures provided in
6.4.2 Distributed Clock Setup.

The servo task processing time
exceeds the set period.

Review the program or servo
frequency to adjust it, so that
the servo task processing time
does not exceed the period.

35



I 8.2. How to Check for Errors

8.2.1. Checking the EtherCAT Status
You can check the EtherCAT status from System Setup of Power PMAC IDE and Diagnosis Mode
of Acontis EC-Engineer.

B System Setup of Power PMAC IDE
You can check the status of the EtherCAT master and slaves in the System Setup page of Power

File  Database

=-4% PowerPMAC (192.162.0.200)
i+ Hardware Diagnosis

| —
_____ : EtherCAT. ™

EtherCAT License Status: Mo License

EtherCAT Master type: ACONTIS

CUsers|OMRON_IPC_T\Desktopleni xml [Browse | [ Download ENIfile
STave stalus
ECAT[8].5laveCount=2 . No Status Emor  Description
ECAT[@].TxTime=3
e S op No | Slave_1001 [GXOD1611]
EcsE PR EEpoE ol EREon 1 opP No | Slave 1002 [GXMD3218]

B Diagnosis Mode of Acontis EC-Engineer
You can check the status of the slaves in the Diagnosis Mode page of Acontis EC-Engineer.

i B EC-Engineer [__]- _\E@lﬂﬂ

Il File View Network Settings  Help

#. Configuration Mode | [ Diagnosis Mode

Project Explorer Device Editor

v @ Class-A Master <connected> General |'\-"ar|'ables || ESC Register ” EEPROM || Extended Diagnosis " DC Diagnosis ” CoE Q[4][]
| o Slave_1001 [GX-OD1611] (1001) |
@ Slave 1002 [GX-MD3218] (1002)

State Machine

Current State |0p
Requested State |0p
Init
Change State Pre-Op Safe-Op
Error State
Current No error
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Select Network then Network Mismatch Analyzer from the menu to verify the network configuration.

-

= Network Mismatch Analyzer

m@ﬂ

List of slaves

Name Configured Slave
Slave_002 [R3& | R88D-KNO1L-ECT [2]

Slave_003 [R8S | RESD-KND1L-ECT [3]

0x00020001 0

Please, compare the configured slaves with the connected slaves. If something is red, you have a
netwaork configuration mismatch!

Revision Alias | Network Slave

0x00020001 | O

Revision Alias

REBD-KNO1L-ECT [2] | 0x00020001 | 1

Close

8.2.2. Checking the Controller Status
In the Status page of Power PMAC IDE, you can check the status of the motor, coordinate system,

and system.

To display the Status page, click Status on the toolbar.

M Global Status

You can check system errors such as the WDT error.

Status: Online[192.168.0.

Motor Status ] Coordinate Status

Global Status

Description

BufSizeErr
ConfigloadErr
Default
FileConfigErr
FlashSizeErr

Status

AbortAll False

False
False
False
False
False

MACRO 5tatus ] ECAT Status ]

Description
HWCha-ngeErr
MoClocks
ProjectLoadErr
PwrOnFault
WD TFault

Status
| i:alse
False
False
False
MNoFault
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Bl Motor Status
You can check deviation errors, limit errors, and other states of the motor.

Coordinate Status] Global Statusl MACRO Status l ECAT Status ]
Motor 0 = ® Motor not activated

| Description Status Description Status
_ False IZtFauIt. i:alse
AmpFault False InPos False
AmpWarn False LimitStop False
AuxFault False MinusLimit False
BIDir Plus PhaseFound False
BlockRequest False PlusLimit False
ClosedLoop False SoftLimit False
Csolve False SoftLimitDir Plus
DacLimit False SoftMinusLimit False
DesVelZero False SoftPlusLimit False
Encloss False SpindleMotor False
FeFatal False TraceCount 0

| FeWarn False TriggerMove False

| GantryHomed False TriggerMotFound False
HomeComplete False TriggerSpeedsel MaxSpeed
HomelnProgress False

B Coordinate Status

You can check deviation errors, limit errors and other states of the coordinate system.

Status: Onling[192.

SSH]

Motor Statu CDDn:ImateStatu] Global Status] MACRO Status l ECAT Status ]
Coordinate System 0 =
Description Status Description Status it
|AddedDwelbis IS LinToPviBuf False
AmpEna False LookAheadActive False
AmpFault False LookAheadChange False
AmpWarn False LookAheadDir Forward
AuxFault False LookfheadFlush False
BlockActive False LookAheadlookBack False
BlockRequest False LockAheadReCalc False
BufferWarn 0 LockAheadStop False
CC3Active False LockAheadWrap False =
CCAddedArc False MinusLimnit False i
CCMode Off MovelMode LineCircle
CCMoveType Dwell PlusLimit False
|| CCOffReq False Proghctive False
| ClosedLoop False ProgProceeding False
ContMotion False ProgRunning False
Csolve False SegEnabled False
DesVelZero False SegMove Off
Encloss False SegMovelccel False
EndDelayActive False SegMoveDecel False B
ErrorStatus MoError SegStopReq False
FeedHeld Off SharpCornerstop False
FeFatal False SoftMinusLimit False
u‘-’am False SoftPlusLimit False
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9. Appendix ECAT]Ji] Structure Elements

The Controller uses motion controller technology developed by Delta Tau Data Systems, Inc.,
(hereafter referred to as DT) in the U.S., however, the ECAT]i] structure elements differ from those of
DT controllers. The following table shows the major changes that have been made from DT

controllers.

Element name

Description

Change

ECATI[i].Enable

ECATI[i].LPIO[K]

ECATIi].Slave[j]
ECATIi].Error

ECAT]Ii].LinkUp
ECAT[i].LPDomainOutputState
ECAT[i].LPDomainState
ECAT[i].LPRxTime
ECAT[i].LPTxTime
ECAT[i].MasterStat
ECAT[i].RTDomainOutputState
ECATIi].RTDomainState

Enabling the EtherCAT
network

Elements of low priority
I/0O module

Slave elements

Error code of enabling
EtherCAT network

Status data structure
elements

0: Disable, 1: Enable (2 and 3 are not
supported.)
Not supported

Not supported

$ 9811000C: Invalid network
configuration

$ 9811002E: Disconnected network
connection

Not supported
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10. Revision History

Revision Revised date Revised content
code
A July 1, 2016 First edition
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